
Chapter 1

Contemplating the switch 
to ArcGIS Pro 

Background 
ArcGIS Pro will seem both familiar and completely new to users of 
ArcMap and ArcCatalog. The GUI arrangement echoes the design 
of ArcMap: the map in the middle, map layers on one side, the data 
catalog on the other, with menus above (figure 1.1). Much of the 
architecture and terminology will persist in the new paradigm: 
geographic data, maps, layouts, geoprocessing tools, tables, joins, 
and so on. However, the implementation and details of how these 
functions are accessed and manipulated takes a completely differ-
ent approach in some cases. For users who know ArcMap well, the 
experience will be initially frustrating as one searches for familiar 
tools and tasks that no longer appear in the same spot, or as one 
gets used to a totally new mindset for some tasks. Too, ArcGIS Pro 
has only gradually developed the capabilities already available in 
ArcMap, so it is possible that the feature sought has not yet been 
implemented. 
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Chapter 1:  Contemplating the switch to ArcGIS Pro 2

However, tapping down the chagrin and opening up to a new 
way of doing certain things will have its rewards. New users unfa-
miliar with ArcMap seem to learn ArcGIS Pro more quickly as it 
follows modern software GUI conventions (a ribbon with tabs and 
context-sensitive menus). In many aspects, it is more intuitive and 
more efficient. After some months of using ArcGIS Pro exclusively, 
I had to return to ArcMap for a month, and my immediate reaction 
was “Oh my, how clunky.” Hopefully after some practice, you too 
will grow to like the new software. 

System requirements 
ArcGIS Pro requires a 64-bit multiprocessor machine with at least 
a dual core, and a quad-core processor or higher is recommended. 
Unlike ArcMap, ArcGIS Pro operates in a multithreaded manner, 
enabling it to take full advantage of multicore computers, which 
ArcMap could not. Significant performance improvements should 

Figure 1.1. ArcGIS Pro 
showing a map of Oregon. 
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Licensing 3

be expected in most cases. ArcGIS Pro operates better when more 
cores are available to it. 

ArcGIS Pro requires a minimum of 8 GB of RAM and a good 
graphics card with at least 2 GB of RAM and 24-bit display color 
depth. For a complete description of system requirements, consult 
the Esri product website, http://pro.arcgis.com/en/pro-app/get-
started/arcgis-pro-system-requirements.htm. 

ArcGIS Pro is tightly joined with ArcGIS Online, a cloud-based 
system built to encourage sharing of GIS data, workflows, and 
other resources between organizations and users. It is strongly 
recommended that the user have an ArcGIS Online organiza-
tional account, which provides access to significantly more data 
and tools. ArcGIS Pro is also designed to run with a fast internet 
connection. Although the software can be run offline, provided the 
data sources are stored on the local computer, it will temporarily 
lose access to basemaps and internet-provided map services. If 
you’re planning to use ArcGIS Pro offline regularly, such as on a 
field laptop, it makes sense to limit maps and tools to use only local 
data on the computer’s hard drive. 

Licensing 
Because ArcGIS Pro is designed to interact with ArcGIS Online, its 
preferred method of licensing is an ArcGIS Online organizational 
account. In this method, the administrator of an ArcGIS Online 
organization creates a user account and assigns to it an ArcGIS 
Pro license from among the total number allotted to the organi-
zation. Extensions may also be assigned if available. Figure 1.2 
shows the screen the ArcGIS Online administrator uses to assign 
licenses and extensions to a user account. When starting ArcGIS 
Pro, users are asked to sign into ArcGIS Online using their account, 
which simultaneously licenses the software and provides users 
access to any content they have created within ArcGIS Online. 
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For continuity with previous licensing methods, Esri also offers 
a concurrent licensing model and a single-use license model, both 
previously used for ArcMap licensing. In the concurrent model, a 
license manager program runs on a server and allocates licenses 
at a user’s request. This model is often called a “floating license,” 
because it is assigned, and then taken back when the user is 
finished, allowing a fixed number of licenses to be shared across 
many computers. In the single-use model, the license is tied to a 
specific computer. 

Capabilities of ArcGIS Pro 
Although it is different in many ways, ArcGIS Pro will eventually 
have the equivalent capabilities of ArcMap and more. This updat-
ing process is ongoing, with new capabilities being added with 
each release. ArcGIS Pro 2.3, for which this book is tested, repre-
sented a significant milestone in which nearly all of ArcMap’s key 
functions were present, and additional capabilities and improve-
ments are still being added. 

ArcGIS Pro integrates the functions of ArcMap, ArcCatalog, 
ArcToolbox, ArcScene, and ArcGlobe within a single interface so 
that 3D data visualization and analysis no longer require open-
ing a separate program. ArcGIS Pro retains the Python® and 
ModelBuilder™ customization modules. Certain aspects that 
users are accustomed to using as separate features, such as COGO 
or Maplex™ for ArcGIS®, are now integrated directly into the 

Figure 1.2. Configuring 
an ArcGIS Pro license for 
a user’s ArcGIS Online 
account. 
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program. The familiar extensions, such as Spatial Analyst or 3D 
Analyst, continue to be available and work in much the same way, 
as additional licensed tools in ArcToolbox. 

However, users should be aware that the very design of ArcGIS 
Pro precludes certain familiar aspects of ArcMap from working 
precisely the same way. In ArcGIS Pro, the design criteria specify 
that most actions are geoprocessing events (taking advantage of 
the multiprocessor computer). Tools have replaced some of the 
common right-click commands, either as a temporary measure 
until the functionality is integrated into the GUI, or as a design 
choice. For example, instead of opening a window to execute a 
selection using table attributes with the Query Builder, you must 
run a tool named Select Layer By Attribute. 

TIP	Can’t find something? Try searching for a tool. 

When should I switch? 
Several factors will affect the decision of when to switch to ArcGIS 
Pro. 

Reasons for making the switch include: 
•	 Improved performance that takes advantage of multicore 

architecture 
•	 Seamless integration of two- and three-dimensional visual-

ization, analysis, and editing 
•	 Improved flexibility in creating dynamic labels 
•	 Creating multiple layouts based on the same map or maps 
•	 Tight integration with ArcGIS Online, making it easier to 

share maps and map services 
•	 A more modern and intuitive GUI 
•	 Expanded use of defaults that can make life easier for inex-

perienced users 
•	 The product life cycle of ArcMap (See the Esri Support Prod-

uct Life Cycles website.) 
ArcMap users may dispute the “more intuitive interface” claim 

when encountering ArcGIS Pro for the first time. In truth, the GUI 
is probably more difficult to learn if you already know ArcMap 
and have become accustomed to certain ways of doing things. In 
general, new users find the ArcGIS Pro GUI easier to learn. Over 
time, you get used to it. 

The software also implements reasonable defaults more than 
ArcMap, hiding complications from beginners. This feature has 
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both benefits and pitfalls. For example, ArcGIS Pro does not 
automatically warn users when two different geographic coordi-
nate systems (datums) are being used in the same map (although 
this warning can be turned on). This choice makes little difference 
unless the user is working at very large scales with precise data, 
and in many situations the issue can be safely ignored. However, it 
can cause difficulties later if inexperienced users compile data for 
a project without being aware that the feature classes and rasters 
use multiple datums. 

When ArcMap retires, the software will continue to be available, 
and people can continue to use it, but it will no longer be updated 
or supported. A similar process occurred when ArcInfo® Worksta-
tion and ArcView became ArcGIS® Desktop. 

Delaying the switch might be wise under some circumstances: 
•	 The organization does not have enough computers capable of 

running ArcGIS Pro. 
•	 Some critical functionality may not yet be available. 
•	 The organization has many custom scripts or tools that must 

be updated and tested. 
•	 Third-party extensions (such as HEC-RAS or MODFLOW) 

may not yet be supported. 
•	 Maps and layouts must be shared with ArcMap users. 

Several other considerations regarding data must also be 
considered: 

•	 ArcGIS Pro does not recognize personal geodatabases or 
ArcInfo coverages. 

•	 The organization and structure of maps and layouts are 
different. 

•	 Data management in ArcGIS Pro has complications not seen 
in ArcCatalog. 

•	 Absolute/relative paths are now fixed by default and have 
less flexibility. 

•	 The Excel™ interpreter is different and seems less forgiving 
than the one in ArcMap. 

As discussed in the next section, even though the data format 
is consistent (the geodatabase), the way that files are organized is 
quite altered and not as flexible. To switch to ArcGIS Pro, you must 
learn different ways of doing things. For example, it is extremely 
difficult to rename a project, so you are stuck with the initial 
name, even if you decide it is inappropriate or confusing. You no 
longer have a choice whether to use absolute or relative paths 
in a document; the choice is made by the software. This feature 
removes a potential trap for inexperienced users, and the defaults 
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usually work well, but experienced users who are accustomed to 
controlling this option may find that they need to change how they 
organize datasets. 

If you use many Excel files, problems may occur. The Excel inter-
preter has had difficulty reading files, in my experience, and usu-
ally I must resort to the comma-delimited CSV file format instead. 
The errors can be delayed and subtle. For example, in one project 
an Excel table imported just fine but generated fatal errors when 
it was exported to a geodatabase. A CSV version of the same table 
was imported and exported to the geodatabase without trouble. 

Mapping differences to consider before switching: 
•	 The default symbols follow a different cartographic style. 
•	 Previous custom styles (such as Civic or Forestry) are not 

included and must be imported. 
•	 Labels are more flexible, but the options are more numerous 

and take getting used to. 
•	 Annotation editing tools are still catching up to ArcMap in 

functionality and reliability. 
The symbol styles have been changed to favor web mapping 

applications and may make it difficult to see multiple layers well. 
Dark colors with white outlines dominate the default symbols, 
and although they can be changed, it adds an extra step when a 
feature class is added to a map. Previous custom style sets must 
be imported from the ArcMap symbol folder, although if a map 
document is imported, the symbols will be included. In general, 
the map document import function works well, although a few 
settings may not be preserved and will need to be reset, such as 
the data frame clip setting. 

Annotation can no longer be saved in a map as graphic text; it 
can only be created as a geodatabase feature class. The annotation 
editing tools have lagged in development. ArcGIS Pro 2.0 had one 
annotation construction tool (Straight), and ArcGIS Pro 2.3 has 
three (Horizontal, Straight, and Curved). The workflow for placing 
unplaced annotation appears to be a manual process of editing the 
attribute table, without the convenient overflow window. Users 
who rely heavily on annotation may wish to stick to ArcMap a 
while longer. 

Geoprocessing considerations to consider before switching: 
•	 Some familiar menu tasks have been replaced by tools. 
•	 Tool outputs are now saved to a project geodatabase by 

default. 
•	 Background processing is “gone.” 
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Overall, geoprocessing is similar, except that familiar functions, 
such as joining two tables, may now require running a tool instead 
of opening a menu. The spatial join, available in ArcMap as a 
relatively simple window, must now be run as the full tool, and 
although the tool has more options, it is complex compared with 
the simple menu in ArcMap. 

The background geoprocessing option has also disappeared as 
a separate option, but only in a sense. ArcGIS Pro, with its multi-
threaded design, essentially runs all tools in the background, and 
it does so more quickly and reliably than the ArcMap background 
geoprocessor. 

All these factors and considerations will influence an organi-
zation in deciding when it is time to switch to the new software. 
Because ArcMap/ArcCatalog and ArcGIS Pro can be installed 
and run on the same computer, users have more time and flexi-
bility when making the switch. (However, it is not recommended 
to run both programs at the same time: both are memory hogs, 
and issues may result if they try to modify the same data simul-
taneously). They use the same data models so that you can work 
with the same datasets using either program. However, maps and 
layouts are completely different. You can import an ArcMap map 
document to ArcGIS Pro and save it to the new format, but ArcGIS 
Pro cannot edit map documents, and ArcMap cannot work with 
ArcGIS Pro layouts. Once created, an ArcGIS Pro layout cannot be 
saved to the older map document format. 

Time to explore 
This exercise assumes that you have installed ArcGIS Pro, have 
been assigned an ArcGIS Pro license, and possess an ArcGIS 
Online organizational account. It is helpful to be familiar with the 
ArcGIS Online terminology for services, such as web maps, feature 
layers, and so on. 

Objective 1.1: Downloading the data for these 
exercises 

A set of data has been assembled to use with this book, and the 
data must be downloaded and installed on your computer. It is 
smart to keep data organized. It is best to put GIS data on drive C; 
the Desktop and user Documents folders don’t always work well, 
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Objective 1.1:  Downloading the data for these exercises 9

especially in networked environments. You can download the data 
from ArcGIS Online, as described next. 

The data is saved to a book group named Switch to ArcGIS Pro 
(Esri Press) in the Learn ArcGIS organization.

1.	 Go to https://www.arcgis.com and log in with an ArcGIS 
Online account. 

2.	 On the Home tab, in the Search box, type Switch to ArcGIS Pro, 
and then click the Search for Groups entry in the list. If no 
groups are found, turn off the option to “Only search in (your 
organization).”

3.	 Click the link to open the Switch to ArcGIS Pro (Esri Press) 
group and find the data, a zip file named SwitchToProData.

4.	 Click the thumbnail and download the file, saving it to a 
location on drive C, rather than in the Documents library or 
on Desktop. 

Figure 1.3. Contents of the 
SwitchToProData folder as 
shown in Windows Explorer. 
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5.	 Extract the zip file. It will create a folder named 
SwitchToProData. The SwitchToProData folder contains an 
ArcGIS Pro project named CraterLake and a PNG image named 
EdwardsCrop (figure 1.3a). Within the CraterLake project folder 
(figure 1.3b) is a file geodatabase, a TIN, a project file (.aprx), a 
layer file (.lyrx), a toolbox, a couple of JPEG (.jpg) images, and a 
multiband Landsat 5 scene. 

Objective 1.2: Starting ArcGIS Pro, signing in, creating 
a project, and exploring the interface 

The preferred licensing model for ArcGIS Pro uses a named user 
account, which is an ArcGIS Online subscription organizational 
account that your administrator has configured with an ArcGIS 
Pro license. 

Instead of a map document used by ArcMap, ArcGIS Pro uses a 
more complex data structure called a project, which will be pre-
sented in detail in chapter 3. 

Figure 1.4. The first time ArcGIS Pro starts, you will be prompted to enter your ArcGIS Online user 
name and password.
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1.	 Start ArcGIS Pro (figure 1.4) and log in using your ArcGIS 
Online account. The initial start screen for ArcGIS Pro presents 
a variety of options (figure 1.5). On the left, you can open a project 
that is already saved by choosing one from the recent list or a 
pinned list, or by browsing for another one. The middle section 
is used to create a new project using one of the system templates: 
Map, Catalog, Global Scene, or Local Scene. The key difference 
between them is the initial type of display that will be created. The 
section on the right lets you access your own templates. 

2.	 In the middle section, under the heading Create a project 
from a system template, choose the Catalog template 
(figure 1.5). 

Figure 1.5. The initial start screen of ArcGIS Pro. 

5.	 Extract the zip file. It will create a folder named 
SwitchToProData. The SwitchToProData folder contains an 
ArcGIS Pro project named CraterLake and a PNG image named 
EdwardsCrop (figure 1.3a). Within the CraterLake project folder 
(figure 1.3b) is a file geodatabase, a TIN, a project file (.aprx), a 
layer file (.lyrx), a toolbox, a couple of JPEG (.jpg) images, and a 
multiband Landsat 5 scene. 

Objective 1.2: Starting ArcGIS Pro, signing in, creating 
a project, and exploring the interface 

The preferred licensing model for ArcGIS Pro uses a named user 
account, which is an ArcGIS Online subscription organizational 
account that your administrator has configured with an ArcGIS 
Pro license. 

Instead of a map document used by ArcMap, ArcGIS Pro uses a 
more complex data structure called a project, which will be pre-
sented in detail in chapter 3. 

Figure 1.4. The first time ArcGIS Pro starts, you will be prompted to enter your ArcGIS Online user 
name and password.
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3.	 Enter LearnPro for the project name (figure 1.6). Click the 
Browse button to specify the new SwitchToProData folder 
as the location. Keep the option to create a new folder, and 
finish creating the project. 

4.	 Examine the interface. 

Figure 1.6. Creating a 
new, blank project named 
LearnPro. 

Figure 1.7. The ArcGIS Pro 
GUI showing a new project. 
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TIP	If your interface looks different from figure 1.7, close every 
window using the X in the upper-right corner, until only the 
tabs remain. Then open the View tab and click the Contents 
button, the Catalog Pane button, and the Catalog View button 
(preferably in that order). You can use the View tab at any time if 
you inadvertently close one of these main panes. 

5.	 Examine the top of the GUI containing the tabs used to 
access features and functions. 

6.	 Review the Contents pane (probably on the left side). This 
pane behaves much like the ArcMap Table of Contents. 

Unlike the Table of Contents in ArcMap, which shows only map 
layers, the Contents pane in ArcGIS Pro portrays other types of 
content as well, as it does here in showing the contents of the 
project. 

The middle section shows the Catalog view, which portrays the 
metadata for, or a preview of, items selected in the Contents pane. 
It is also used to edit metadata. 

7.	 Click several entries in the Contents pane. The Catalog view 
updates to show the items contained within the clicked item. 
Note that in the top half of the Contents pane, the Project folder 
links to resources saved to the computer. The bottom half, the 
Portal folder, accesses internet servers. 

8.	 Peruse the Catalog pane on the right side; it is analogous to 
the Catalog window in ArcMap. Although it is similar to the 
Catalog view in the center of the GUI, it has fewer functions 
(for example, not allowing you to preview data). The terms 
pane and view have specific meanings in ArcGIS Pro. Panes are 
dockable windows that contain commands and tools, whereas 
views contain objects that you are working with, such as a map, 3D 
scene, layout, or table. A window is a container that can display 
multiple panes or views. Three windows are visible in figure 1.7: 
one containing the Contents pane, one containing the Catalog view, 
and one containing the Catalog pane. 

3.	 Enter LearnPro for the project name (figure 1.6). Click the 
Browse button to specify the new SwitchToProData folder 
as the location. Keep the option to create a new folder, and 
finish creating the project. 

4.	 Examine the interface. 

Figure 1.6. Creating a 
new, blank project named 
LearnPro. 

Figure 1.7. The ArcGIS Pro 
GUI showing a new project. 
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9.	 Compare the bottom of the Catalog pane in figure 1.7 with 
your ArcGIS Pro GUI. The window in the figure contains three 
tabs representing three different panes docked in this window: 
Symbology, Geoprocessing, and Catalog. Your configuration may 
not match: the Symbology and Geoprocessing tabs are probably 
not visible in your project at the moment, because you may not 
have opened the panes yet. One characteristic of the ArcGIS Pro 
GUI is that it constantly changes depending on what the user is 
doing. 

Objective 1.3: Accessing maps and data from ArcGIS 
Online 

ArcGIS Pro is designed to work closely with ArcGIS Online, so 
that you can access maps and data that have been saved by others. 
In the Contents pane, the upper section, Project, lists data stored 
on the local computer or a local network drive. The lower sec-
tion, Portal, lists data available in ArcGIS Online or other GIS 
servers, including your own saved content, My Content; content 
available to your ArcGIS Online groups, the table in the graphics 
Groups; all content available in ArcGIS Online, All Portal; and the 
ArcGIS Living Atlas of the World data available to ArcGIS Online 
subscribers. 

Much of the content accessed by ArcGIS Pro (figure 1.8) is like 
the content available to ArcMap, although the terminology has 
changed. A feature service and an image service are now called a 
feature layer and an imagery layer, respectively. Next, you can 
search for and add a couple different types of data. 
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1.	 In the Contents pane, click the All Portal entry and type a 
search term in the box in the Catalog view. 

2.	 Note the different types of items available. Click on one of 
the items to view its metadata. 

3.	 Click the Preview option at the bottom of the metadata 
section to examine a preview. Switch between the Details 
and Preview tabs as needed. 

4.	 Take a moment to examine the Insert tab that is currently 
visible. 

5.	 Right-click a web map  in the Catalog view and click Add 
and Open. A web map is a shared map that accesses only GIS 
services. The map and its contents are displayed in the project. A 
new map view is added to the center window, and the Contents 
pane now shows the map layers, much like the ArcMap Table of 
Contents. In the Catalog pane, a new heading, Maps, is added. 

Name in ArcGIS Pro Name in ArcMap Description 

Feature layers Feature service Serve point, line, or polygon features and their 
attributes

Imagery Image service Serve raster data products such as satellite images or 
aerial photography in analyzable form.

Map image layers Map service Map cartography based on vector or raster data 
dynamically rendered and served as image tiles.

Tile layers Hosted tile 
services

A collection of web-accessible tiles that reside on 
a service, prerendered for rapid display. Includes 
basemaps and vector basemaps.

Elevation layers Elevation services Cached elevation image tiles in a compressed 
format, suitable to show terrain in 3D scenes.

Web tools Geoprocessing 
services 

Geoprocessing function that runs on the GIS server 
rather than using local GIS software capabilities.

Scenes Scenes Symbolized 3D spatial content for visualization. May 
include 2D and 3D layer services.

 Web maps Web maps Maps based solely on GIS services. May include 
other types of services listed in this table.

Packages Packages Data uploaded to ArcGIS Online for sharing. Includes 
layer, map, project, rule, or geoprocessing packages.

Scene layers Scenes Collection of 3D objects and z-values, including 
points, 3D objects, integrated meshes, or point 
clouds.

Tables Tables Rows and columns of information. May contain 
locations and be drawn on the map.

Figure 1.8. Types of 
services available to ArcGIS 
Pro in ArcGIS Online. The 
terminology has changed 
somewhat for ArcGIS Pro, 
and the services are shown 
with different names than 
when adding them in 
ArcMap. 

9.	 Compare the bottom of the Catalog pane in figure 1.7 with 
your ArcGIS Pro GUI. The window in the figure contains three 
tabs representing three different panes docked in this window: 
Symbology, Geoprocessing, and Catalog. Your configuration may 
not match: the Symbology and Geoprocessing tabs are probably 
not visible in your project at the moment, because you may not 
have opened the panes yet. One characteristic of the ArcGIS Pro 
GUI is that it constantly changes depending on what the user is 
doing. 

Objective 1.3: Accessing maps and data from ArcGIS 
Online 

ArcGIS Pro is designed to work closely with ArcGIS Online, so 
that you can access maps and data that have been saved by others. 
In the Contents pane, the upper section, Project, lists data stored 
on the local computer or a local network drive. The lower sec-
tion, Portal, lists data available in ArcGIS Online or other GIS 
servers, including your own saved content, My Content; content 
available to your ArcGIS Online groups, the table in the graphics 
Groups; all content available in ArcGIS Online, All Portal; and the 
ArcGIS Living Atlas of the World data available to ArcGIS Online 
subscribers. 

Much of the content accessed by ArcGIS Pro (figure 1.8) is like 
the content available to ArcMap, although the terminology has 
changed. A feature service and an image service are now called a 
feature layer and an imagery layer, respectively. Next, you can 
search for and add a couple different types of data. 
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6.	 Expand the Maps entry in the Catalog pane and note that the 
map is now listed there. 

7.	 Examine the ribbon along the top. It switched automatically 
from the Insert tab to the Map tab when the map was added. 

8.	 Switch back to the Insert tab. You may notice that additional 
commands are now available. Tabs update depending on what the 
user is doing and what is open. 

9.	 Return to the Map tab, and examine it for familiar 
capabilities, such as the basemap, bookmarks, adding data, 
and so on. The Catalog view remained open as a second tab in the 
display window. 

10.	Use the tabs to switch back and forth between the map view 
and the Catalog view. 

11.	Open the Catalog view again, right-click a feature layer  
(not any other kind of layer) from your search group, and 
click Add to New > Map to add it to a new map, different 
from the first. 

12.	 In the Contents pane, click twice slowly on the map name 
(currently Map) and change it to something more descriptive. 

13.	Examine the contents of the Maps folder in the Catalog pane, 
noting that it now has two maps listed. 

14.	Close one of the maps using the X on the tab at the top of 
the display window. The map closes but is still available in the 
Catalog pane. 

15.	Click the Save button on the Quick Access Toolbar at the top 
of the GUI to save the LearnPro project. The connections to 
your new maps will be saved to the project. 

Like ArcMap, ArcGIS Pro stores only links to these ArcGIS 
Online maps and data services. 

TIP	Maps in projects are analogous to data frames in an ArcMap 
map document. 
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Objective 1.4: Arranging the windows and panes 
As in ArcMap, windows can be docked in the program or float 
above it. Objects within windows can be rearranged in different 
ways: stacked on top of each other, side by side, top over bottom, 
and so on. The docking icon should already be familiar to ArcMap 
users, and it works much the same way in ArcGIS Pro (figure 1.9). 

1.	 In the display window, click the map tab and drag to pull it 
out of the program onto the desktop, making it a floating 
window. 

2.	 Drag it back into the center display area to make the docking 
icon appear. Drag the map tab to the center of the icon and 
release to stack the map back on top of the Catalog view 
again. 

3.	 Drag the map away again and use the docking icon to 
arrange the map view and Catalog view side by side. 
Experiment until all five docking locations have been used. 

4.	 In the Catalog pane, open the Maps entry, if needed, and 
double-click the second map to open it. 

5.	 Experiment with arranging the three views. Panes can also be 
arranged within their windows. 

6.	 Open the second map, the one containing the feature layer, 
and click its title bar to ensure that it is the active view. The 
Contents pane shows the content of the active view. 

7.	 If the feature layer loaded as a group layer, expand it until an 
individual layer is visible. 

8.	 In the Contents pane, right-click the layer and click 
Symbology to open the Symbology pane. 

Figure 1.9. The docking icon is used to arrange panes 
within a window: stacked (drop on the center) or side by 
side (left, right, top, or bottom). 
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9.	 Drag and dock the Symbology pane in different locations: 
below the Contents pane, on top of the Catalog pane, next to 
the Catalog pane, and so on until comfortable with arranging 
panes. 

10.	Save the LearnPro project. 

TIP	When two panes are stacked in a window, use the top bar to 
move the window with all the panes together. To move a single 
pane out of a window, click its tab on the bottom. 

Objective 1.5: Accessing the help 
The help files are normally accessed in a web browser window, 
rather than being part of the program as in ArcMap. For offline 
work, the help files can also be downloaded and installed 
separately. 

1.	 Open the Project ribbon and click Help. Your default browser 
opens to the help pages. 

2.	 Widen the browser window, if needed, to see the outline on 
the left and the text on the right (figure 1.10). 

3.	 Expand some entries in the outline to explore the content 
and organization. 

4.	 Find the Search icon and click to open the search page. Type 
a search term, such as labels, click Search or click Enter on 
your keyboard, and select one of the topics that appears. 

5.	 Examine the breadcrumb trail to locate the content in the 
Table of Contents outline. Click on a higher level to climb out 
to more general topics. 

6.	 Examine each of the tabs, and then return to the Help tab. 

7.	 Spend some time exploring ArcGIS Pro Help until you are 
comfortable using it. 

8.	 Minimize the browser, making the help access quicker next 
time, and return to ArcGIS Pro. 
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Objective 1.6: Importing a map document 
ArcGIS Pro can easily import existing map documents from 
ArcMap. Every data frame in the map document will be imported 
as a map, and new layouts will be created in the project. Folder 
connections needed to access the data in the map document, styles 
used to display the features, and most data frame and layer set-
tings will be imported. If you have a map document (.mxd) on your 
computer, you can try importing it now. 

1.	 Close any open maps. 

2.	 Open the Insert tab, and in the Project group, click the 
Import Map button. 

3.	 Navigate to a map document, select it, and click OK. Wait 
while the map document imports from ArcMap—it may take a 
few minutes. 

4.	 Examine the map views in the main window. One is created 
for each data frame in the map document. 

5.	 In one of the imported maps, double-click a layer to open 
its properties and examine the Source setting. Close the 
properties when finished. The data upon which the map layers 
are based is imported as paths to the original source in its original 
location. No data will be copied into the project. 

Figure 1.10. The help for 
ArcGIS Pro.
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below the Contents pane, on top of the Catalog pane, next to 
the Catalog pane, and so on until comfortable with arranging 
panes. 

10.	Save the LearnPro project. 

TIP	When two panes are stacked in a window, use the top bar to 
move the window with all the panes together. To move a single 
pane out of a window, click its tab on the bottom. 
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The help files are normally accessed in a web browser window, 
rather than being part of the program as in ArcMap. For offline 
work, the help files can also be downloaded and installed 
separately. 

1.	 Open the Project ribbon and click Help. Your default browser 
opens to the help pages. 

2.	 Widen the browser window, if needed, to see the outline on 
the left and the text on the right (figure 1.10). 

3.	 Expand some entries in the outline to explore the content 
and organization. 

4.	 Find the Search icon and click to open the search page. Type 
a search term, such as labels, click Search or click Enter on 
your keyboard, and select one of the topics that appears. 

5.	 Examine the breadcrumb trail to locate the content in the 
Table of Contents outline. Click on a higher level to climb out 
to more general topics. 

6.	 Examine each of the tabs, and then return to the Help tab. 

7.	 Spend some time exploring ArcGIS Pro Help until you are 
comfortable using it. 

8.	 Minimize the browser, making the help access quicker next 
time, and return to ArcGIS Pro. 
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6.	 In the Catalog pane, expand the Layouts entry and find the 
new layout added from the map document. Double-click it 
to open it. Most settings will be copied to the new layout, but you 
may find that a few are not because of differences between ArcMap 
and ArcGIS Pro. You may need to adjust some layouts or maps 
to get the same result as the original. Once imported, however, 
layouts cannot be exported back to ArcMap format.

7.	 Examine the layout and see if you notice any difference 
between the ArcGIS Pro and ArcMap versions. 

8.	 In the Catalog pane, expand the Styles entry. Custom styles 
used in the map document, if any, would be imported and shown 
here. 

Remember, ArcGIS Pro can have multiple layouts. 

9.	 Import another map document if you wish. 

10.	Save the LearnPro project to save the imported map(s) and 
layout(s). 
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